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2.Product Designing Using TDD
In this chapter we will go through the basic steps of developing handheld consumer products
using Top-down design (TDD) methodology.

In today’s world, consumer products are more and more stylish and ergonomic. This requires the
use of complex curves and surfaces. So you should have good knowledge of curve and surface
building techniques to be a good designer for aesthetically pleasing products. In the following
exercises, we will show step-by-step procedure for creating the required features so basic
knowledge of surface and solid modeling should be sufficient.

We will use the basic tools for top-down design that we learned in the previous chapter. The
focus of the exercises covered in this section is the good understanding of the top-down design
methodology. Here we will emphasize the top-down design “concept” and not the “tools” that
Creo offers. In this way it is hoped that the reader will develop a strong interest in this design
approach and will follow the remaining chapters vigorously.

In the following exercises we will use the Internal Copy Geometry Feature to communicate data
from skeleton to the individual components. Although we can use the External Copy Geometry
Feature instead of Internal Copy Geometry with same end results but here we will not go into
discussion of, what are the benefits of External Copy Geometry over Internal Copy Geometry
Feature. You should concentrate on the core top-down design concept. In the later chapters you
will see why External Copy Geometry is preferred over Internal Copy Geometry feature. Then if
you want you can easily convert the Internal Copy Geometry Features to External Copy
Geometry features.

In TDD process the term Split Surface is often used. Here it means the surface where two
components of a product join. It is different from the splitting surface (or parting surface) while
creating the tooling of a molded or casted component.

While designing products with non-planar split surface, it becomes necessary to begin with split
surfaces. This will be shown in the following exercises.
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Exercise 1

In this exercise we will create a plastic product consisting of three parts. The completed product
is shown below.

The common attributes between TOP and BOTTOM parts are as follows

1. Profile of both components is same.
2. Both components join along a 3-D surface

The common attributes between TOP and LED COVER parts are as follows

1. Profile of LED COVER and accommodating cut in the TOP part is same.
2. The outer shape of both parts follow a common surface

So we will create the geometry in the skeleton model that controls the above common attributes.

Only, the geometry that affects or crosses more than one component (or has to be referenced by
more than one component) should be placed in the skeleton.

Set the working directory to PHONE folder and open the assembly PHONE.ASM

Notice that there are three components assembled with Default constraints. Also notice that all
components have only default datum features as shown below. (Note: Placement constraint of a
component is only visible if Placement folder option is checked in Model Tree Items dialog box.)
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Skeleton model is already defined. We will add the required geometry in it.

Building the Skeleton

Open the skeleton model PHONE_SKEL.PRT in a separate window and notice that it consists of
datum curves as shown below. (Note: Datum curves and background are not shown in default
colors in the exercise to make the display more distinct. You will see different colors depending
upon the configuration of your system.)

The white rectangular curves represent the horizontal and vertical boundaries of the phone
assembly. These curves are sketched just to facilitate dimensioning and constraining of other
features.

Now we will create a surface that represents the top of the product and will be shared by the
TOP and LED COVER components.
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Pick icon to invoke the sweep tool.

Notice that system is asking to select the trajectory, so pick the following curve.

Pick tab to open the References slide-up panel.

Change the “Section plane control” option to Normal To Projection.

Appearance of the References slide-up panel will change as shown below.
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Notice that “Direction reference” collector is now active. So select SKL_TOP datum plane as
direction reference.

System projects the Origin Trajectory along the selected references (SKL_TOP Datum Plane in
this case) and the section plane stays normal to this trajectory as the section is swept along the
trajectory.

Pick to create the feature as a surface.

Pick and select the end points of BOUNDARY_PROFILE datum curve as references as
elaborated in figure below.
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Sketch two centerlines that pass through selected references as shown below.

Pick and sketch an arc as shown below.

We have aligned the end points of the arc to the centerlines just to make sure that the surface
generated will intersect with other features that lie within the part boundaries.

Pick after completing the sketch.

Pick icon to complete the sweep feature. The surface will appear as shown below. This new
surface will be called as “top surface”.
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Normal To Projection option makes sure that the surface does not overlap or intersects itself and
hence there is no manufacturing problem for the final components using this surface as
reference.

Now we will create another surface that will be used to split the TOP and BOTTOM parts (in
other words, the surface at which both these components join).

Pick icon to invoke the sweep tool.

Pick the following curve as reference.

Pick tab and change the “Section plane control” option to Normal To Projection.

Select SKL_TOP datum plane as direction reference.

Pick to create the feature as a surface.

Pick and select the end points of BOUNDARY_PROFILE datum curve as references as
elaborated in figure below.
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Sketch two centerlines that pass through selected references as shown below.

Pick and sketch an arc as shown below.

Pick after completing the sketch.
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Pick icon to complete the sweep feature. This new surface will be called as “split surface”.

Communicating the Design Information

In this exercise we will create two Publish Geometry features in the skeleton model.

Pick on the Tools tab as shown below.

The Publish Geometry dialog box will appear. As the surface collector is active so pick the split
surface as shown in figure below..

Pick in the Chain collector to activate it as shown below.
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Now select the following two curves (highlighted) while holding down the Ctrl key. (These curves
are named MAIN_PROFILE and INTERLOCK_LIP in the model tree.)

All the selected references (chains) will appear in the PUBLISHED GEOMETRY dialog box as
shown below.
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Pick to apply the changes and exit the dialog box.

To create the second publish geometry feature, again pick on the Tools tab.

As the surface collector is active so pick the top surface as shown in figure below.

Pick in the Chain collector to activate it and select the following highlighted curve.
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Pick to apply the changes and exit the dialog box.

Now we will create Copy Geometry features in individual parts. These Copy Geometry features
will reference the Publish Geometry features created in the skeleton part. We will create the
Copy Geometry feature in the assembly environment so make the assembly window
PHONE.ASM active.

First we will create a copy geometry feature in the PHONE_BOTTOM.PRT

Right-click the PHONE_BOTTOM.PRT in the model tree and select Activate.

To create a copy geometry feature, pick on the Model tab.

The Copy Geometry dashboard will appear. Notice that Publish Geometry reference collector is
active by default.
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So select the first publish geometry feature in the skeleton part, by picking it in the model tree, as
shown below.

Pick to apply the changes and exit the dashboard.

Now right-click the PHONE_TOP.PRT in the model tree and select Activate.
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We will create two copy geometry features in this part.

To create a copy geometry feature, pick on the Model tab.

As Publish Geometry reference collector is active so select the first publish geometry feature in
the skeleton part as shown below.

Pick to apply the changes and exit the dashboard.

Notice that the PHONE_TOP is still active so again pick on the Model tab.

Select the second publish geometry feature in the skeleton part.
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Pick to apply the changes and exit the dashboard.

Now right-click the PHONE_LED_COVER.PRT in the model tree and select Activate.

To create a copy geometry feature, pick on the Model tab.

Select the second publish geometry feature in the skeleton part.

Pick to apply the changes and exit the dashboard.

Creating Model Geometry

Now the information is captured from the skeleton model into the individual components. We will
use the Copy Geometry features as a reference to build geometry in the parts.

First Part

Open the PHONE_BOTTOM.PRT in the new window

Pick the Extrude Tool icon to invoke Extrude tool.

Select the sketching references as shown below
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Pick icon and select the following loop (outermost).

After completing the sketch specify the blind depth of 25 in the direction as shown below. Set the
view to ISO1 to avoid any confusion.

Pick icon or middle-click to complete the feature.

Now we will create a surface copy feature. So change the filter setting to Geometry as shown
below.
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Select the following surface (highlighted) by picking on it.

Pick copy icon ( ) on the Model tab or press Ctrl+C on the keyboard.

Pick paste icon ( ) on the Model tab or press Ctrl+V on the keyboard.

The Copy dashboard will appear. Pick icon or middle-click to complete the feature.

To unclutter view, pick icon on the View tab and hide the 07___PRT_COPY_GEOM layer.

Now pick the newly created surface as shown below.

Pick to invoke Solidify tool.

In the Solidify dashboard pick icon to create the feature as cut.
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Pick the icon to reverse the direction of feature creation.

Now the preview should appear as shown below. (Note the direction of arrow). Set the view to
ISO1 to avoid any confusion.

Pick icon or middle-click to complete the feature. The part will appear as shown below.

Now we will apply draft and rounds to this part then shell it.

Select the surface highlighted in the following figure.

Pick to access the Draft tool.
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Notice that Draft hinges collector is active, so select the following edge with left mouse pick.

Hold down the Shift key and place the mouse pointer over any edge belonging to top surface
and Right-Click to query.

Pick with left mouse button when system highlights the Tangent chain as shown below.

Pick in the Pull Direction collector and select the TOP Datum plane as reference.
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Enter 3 in the Draft angle field on the dashboard.

Pick the icon to reverse the pull direction.

The preview of the drafted surface will appear as shown below.

Make sure that Pull Direction arrow points in the direction shown.

Pick to complete the feature.

Now select the following edge for applying round.

Pick to access the Round tool.

Enter 2.25 as the radius value

Pick icon to complete the feature.

Pick to access the Shell tool.

Enter 2 as the thickness value
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Select the following highlighted surface to add it to Removed surfaces collector.

Pick icon to complete the feature. The part will appear as shown below.

Now we will create the interlock detail so that both parts are aligned and positioned relative to
each other during the assembly. The cross-section of completed assembly is shown below.



Chapter 2 Product Designing Using TDD

27

You should notice the gap between Top and Bottom halves. The purpose of this gap is to
disguise any mismatch due to manufacturing tolerances between these parts.

Now we will define an Offset feature to create the interlock lip.

So select the following surface of the part.

Pick to access the Offset tool.

Change the Offset type toWith Draft by picking the icon in the Offset Type list.

Pick tab in the References slide-up panel.

Select the sketching references as shown below. Also flip the direction of sketch plane for clear
view.
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The datum curve to be used as reference is hidden. So first pick on View tab and unhide the
07___PRT_COPY_GEOM layer and hide the 06___PRT_ALL_SURFS layer. You do not need to
exit the sketcher for this operation.

Pick icon and select the loop (innermost) as shown below.

Specify 0.1 as the offset value. The offset direction should be outwards.

The purpose to this offset is to have clearance between lip geometry of both parts.

Pick to complete the sketch.

Enter 1.5 as the offset value for feature and hit Enter key.

Enter 5 as the draft angle and hit Enter key.

Pick tab and change the “Side surface normal to” option to Sketch.
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Pick to flip the direction of feature creation.

The preview will appear as shown below.

Make sure that Offset Direction arrow points in the direction shown. It will make sure that
material is removed from the part.

Pick icon to complete the feature. The part will appear as shown below.
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Now we will create an offset feature that will create a gap between top and bottom halves to
disguise any mismatch between both parts.

So select the following surface of the part (highlighted).

Pick to access the Offset tool.

Change the Offset type to Expand by picking the icon in the Offset Type list.

Enter 0.5 as the offset value

Pick the icon to reverse the direction of offset and the preview will appear as shown below.

Make sure that Offset Direction arrow points in the direction shown. It will make sure that
material is removed from the part.

Pick icon to complete the feature.

Second Part

Now we will create the geometry for second part. So open the PHONE_TOP.PRT in the new
window.
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Pick the Extrude Tool icon to invoke Extrude tool.

Select the sketching references as shown below

Pick icon and select the following loop (outermost)..

After completing the sketch specify the blind depth of 40 in the direction as shown below. Set the
view to ISO1 to avoid any confusion.



Top-Down Design - A Practical Approach Creo 1.0

32

Pick icon or middle-click to complete the feature.

Now we will create surface copy features.

Change the filter setting to Geometry as shown below.

Select the following highlighted surface (split surface).

Pick copy icon ( ) on the Model tab or press Ctrl+C on the keyboard.

Pick paste icon ( ) on the Model tab or press Ctrl+V on the keyboard.

The Copy dashboard will appear so pick or middle-click to complete the feature.

Now select the following highlighted surface (top surface).
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Pick copy icon ( ) on the Model tab or press Ctrl+C on the keyboard.

Pick paste icon ( ) on the Model tab or press Ctrl+V on the keyboard.

The Copy dashboard will appear so pick or middle-click to complete the feature.

To unclutter the screen, Pick icon on View tab and hide the 07___PRT_COPY_GEOM layer

Now pick the surface as shown below (copy of split surface).

Pick to invoke Solidify tool.

In the Solidify dashboard pick icon to create the feature as cut.

The preview should appear as shown below. (Make sure that Direction arrow points in the
direction shown.
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Pick icon or middle-click to complete the feature. The part will appear as shown below.

Now pick the surface as shown below (copy of top surface).

Pick to invoke Solidify tool.

In the Solidify dashboard pick icon to create the feature as cut.

Pick the icon to reverse the direction of feature creation.
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Now the preview should appear as shown below. (Make sure that Direction arrow points in the
direction shown.

Pick icon or middle-click to complete the feature. The part will appear as shown below.

Now we will apply draft and rounds to this part then shell it.

Select the following surface.

Pick to access the Draft tool.

Notice that Draft hinges collector is active so select the following edge with left mouse pick.
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Hold down the Shift key and place the mouse pointer over any edge forming the bottom surface
and Right-Click to query.

Pick with left mouse button when system highlights the Tangent chain as shown below.

Pick in the Pull Direction collector and select the TOP Datum plane as reference.

Enter 3 in the Draft angle field on the dashboard.

The preview of the drafted surface will appear as shown below.

Make sure that Pull Direction arrow points in the direction shown.



Chapter 2 Product Designing Using TDD

37

Pick icon to complete the feature.

Now select the following edge for applying round.

Pick to access the Round tool.

Enter 3 as the radius value

Pick icon to complete the feature. Part will appear as shown below.

Pick to access the Shell tool.

Enter 2 as the thickness value

Select the bottom surface (after rotating the part) to add it to Removed surfaces collector.
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Pick icon to complete the feature. The part will appear as shown below.

Now we will define an Offset feature to create the interlock lip.

So select the following surface of the part.

Pick to access the Offset tool.
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Change the Offset type toWith Draft by picking the icon in the Offset Type list.

Pick tab in the References slide-up panel.

Select the sketching references as shown below. Also flip the direction of sketch plane for clear
view.

The datum curve to be used as reference is hidden. So first pick and unhide the 07___
PRT_COPY_GEOM layer and hide the 06___PRT_ALL_SURFS layer.

Pick icon and select the loop (innermost) as shown below.

Pick to complete the sketch.

Enter 1.5 as the offset value and hit Enter key.

Enter 5 as the draft angle and hit Enter key.

Pick tab and change the “Side surface normal to” option to Sketch.

The preview will appear as shown below.
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Make sure that Offset Direction arrow points in the direction shown. It will make sure that
material is added to the part.

Pick icon to complete the feature.

To create the cut to accommodate the LED_COVER part, we will create an extrude feature.

Pick to invoke Extrude tool.

Select the sketching references as shown below.

Pick icon and select the following loop (07___ PRT_COPY_GEOM layer should be
unhidden).
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After completing the sketch pick icon to create the feature as cut.

Specify the depth option to Through All.

Pick icon or middle-click to complete the feature and part will appear as shown below.

Third Part

Now we will create the geometry for PHONE_LED_COVER.PRT. So open it in a new window.



Top-Down Design - A Practical Approach Creo 1.0

42

There may be lot of techniques to build the geometry for this part but we will follow the simplest
one.

Change the filter setting to Geometry and select the following highlighted surface.

Pick copy icon ( ) on the Model tab or press Ctrl+C on the keyboard.

Pick paste icon ( ) on the Model tab or press Ctrl+V on the keyboard.

The Copy dashboard will appear so pick icon or middle-click to complete the feature.

Hide the 07___ PRT_COPY_GEOM layer to unclutter the screen.

Now select the newly copied surface as shown below.

Pick to invoke Thicken tool

Pick to flip the direction of feature creation.

Enter 2 as the thickness value.
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Direction of arrow should be as shown in the above figure to make sure that material is added to
the desired side of surface.

Pick to complete the feature.

Now we will create an extruded cut to remove the unwanted geometry.

Pick to invoke Extrude tool.

Select the sketching references as shown below

Unhide the 07___ PRT_COPY_GEOM layer should be unhidden.

Pick icon and create a loop that is offset by -0.2 from the profile curve as shown below.
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The purpose to this offset is to have clearance between the parts.

After completing the sketch pick icon to create the feature as cut.

Specify the depth option to Through All.

Pick the icon to change material direction (the right-most icon).

Hide the 07___ PRT_COPY_GEOM layer and the preview will appear as shown below (notice
the direction of arrows)

Pick icon to complete the feature.
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It completes the basic shape of the part. We will not create the further details for this part as the
purpose of this exercise is to familiarize how to achieve the form and fit between parts.

Switch to the assembly window and hide 07___PRT_COPY_GEOM layer. The assembly of
components will appear as shown below.

Now if you modify any dimension in the skeleton and regenerate the assembly. You will see that
all the parts referencing that geometry update accordingly after regeneration.
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Exercise 2

In this exercise we will create a plastic housing for a remote-control consisting of four parts. The
completed product is shown below.

The front side of the remote is shown below

The common attributes between TOP and BOTTOM parts are as follows

1. Profile of both components is same.
2. Both components join along a 3-D surface
3. The hole at front side should be aligned and of same diameter in both parts
4. The elliptical cut at the front side should be of same size and shape in both parts.
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The bottom side of the remote is shown below. Nomenclature used for differenct areas of battery
cover is also shown in the figure.

The common attributes between BOTTOM and BATTERY COVER parts are as follows

1. Profile of BATTERY COVER and accommodating cut in the BOTTOM part is same.
2. The outer shape of both parts (including underside and side) follow common surfaces
3. The round value is same for both parts

So we will create the geometry in the skeleton model that controls the above common attributes.

Only, the geometry that affects or crosses more than one component (or has to be referenced by
more than one component) should be placed in the skeleton.

Set the working directory to REMOTE folder and open the assembly REMOTE.ASM

Notice that there are four components assembled with Default constraint.
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Building the Skeleton

Open the skeleton model in a separate window and it will appear as shown below. Notice down
the name of the quilts in the model tree. These quilts will be referred by these names in the
following text.

Here you can see top and bottom surfaces and profile datum curve. Other geometry is placed on
custom layers and hidden. The white curves represent the horizontal and vertical boundaries of
the remote assembly.

We will create the skin of the remote-control completely in the skeleton model because top,
bottom and side surfaces and rounds are shared by multiple parts.

Pick the Extrude Tool icon to invoke Extrude tool.

Select the sketching references as shown below

Hide the 06___PRT_ALL_SURFS layer for clear view.

Pick icon and select the loop shown in figure below.
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After completing the sketch, pick to create the feature as surface.

Change the depth option to To Selected ( ) and pick the following curve.

Pick or middle-click to complete the feature.

Before proceeding hide the SKL_CURVE_BOUNDAY and SKL_CURVE_PROFILE layers. Also
unhide the 06___PRT_ALL_SURFS layer before proceeding.

Now we will merge the surfaces together to get the outer skin of the remote-control body.

Change the filter setting to Quilts as shown below.

Select the extruded quilt and BOTTOM_SURF quilt while holding down the Ctrl key as shown in
the figure below.
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Pick to invoke the Merge tool. Make sure that preview appears as shown below.

Pick to complete the feature and part will appear as shown below.
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Now select the merged quilt and TOP_SURF while holding down the Ctrl key as shown in the
figure below.

Pick to invoke the Merge tool.

Pick to complete the feature and part will appear as shown below.

Now we will apply split draft to the side surfaces so that TOP and BOTTOM parts are
manufacturable using injection molding process. The side surfaces will be split about the split
surface (the surface at which both components join). To achieve this, we need to create a datum
curve to be used as neutral curve.

Further material is not included in the free download. You can buy the complete
tutorials at http://www.caeuniversity.com/buy/. Thanks for your review of the
training material.
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